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Preface
This preface contains the following topics:

• “About this guide” on page vi

• “Accessing Agilent Automation Solutions user guides” on 
page viii
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About this guide

Who should read this guide

This user guide is for people with the following job roles:

 

Installers, integrations, lab managers, and administrators are users who must 
have technical expertise. In addition, lab managers and administrators are 
individuals or groups responsible for the use and maintenance of the Labware 
MiniHub and for ensuring that operators are adequately trained.

What this guide covers

This guide describes the G5584A Labware MiniHub, the operation of the 
hardware components, and the use of the diagnostics software and ActiveX 
control.

Software version

The G5584A Labware MiniHub requires the following software versions at a 
minimum:

• Microsoft Windows 10 64- bit operating system

• One of the following:

– VWorks Automation Control software v13.1.0 and MySQL 5.7

– Labware MiniHub ActiveX control v13.1.0

This guide documents Labware MiniHub Diagnostics v13.1.0, which can be 
invoked from either the VWorks software or Labware MiniHub ActiveX control.

Note: The Labware MiniHub ActiveX control is included in the VWorks ActiveX 
Controls installer.
                                                        

Job role Responsibilities

Installer Unpacks, installs, and tests the device before it is used.

Integrator Configures hardware and writes software.

Lab manager, 
administrator, 
or technician

• Manages the automation system that contains the 
device

• Develops the applications that are run on the system

• Develops training materials and standard operating 
procedures for operators

Operator Performs the daily production work on the device and 
solves routine problems.
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Related guides

The G5584A Labware MiniHub User Guide should be used in conjunction with 
the following documents, if applicable:

• G5584A Labware MiniHub Safety and Installation Guide. Presents the 
safety precautions, emergency stop procedure, site preparation information, 
and installation instructions.

• Automation Solutions Products General Safety Guide. Describes the 
general safety precautions, intended product use, and the list of safety 
labels for the Automation Solutions products.

• Applicable robot user guide. Explains how to set up the robot and set 
teachpoints at integrated devices. For example, see the BenchCel 
Microplate Handler User Guide for details on how to set the BenchCel 
teachpoints at the Labware MiniHub.

• Applicable automation control software user guide. Explains how to 
create and run protocols. If you are using the VWorks software, see the 
VWorks Automation Control Setup Guide and VWorks Automation Control 
User Guide.

Related information

For information about... See...

Accessing related user guides “Accessing Agilent Automation 
Solutions user guides” on page viii

Reporting problems “Reporting problems” on page 60
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Accessing Agilent Automation Solutions user guides

About this topic

This topic describes the different formats of user information and explains how 
to access it for the Agilent Automation Solutions products.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the Internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent website. You can search the online knowledge base or download the 
latest version of any PDF file from the Agilent website at www.agilent.com/
chem/askb. 

Accessing safety information

Safety information for the Agilent Automation Solutions devices appears in the 
Automation Solutions Products General Safety Guide and in the 
corresponding device safety guide or user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:
• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows 10 desktop, select Start > All apps > Agilent Technologies > 
VWorks Knowledge Base.

http://www.agilent.com/chem/askb
http://www.agilent.com/chem/askb
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Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
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Features in the Knowledge Base window

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you to search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
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1
Introduction

This chapter contains the following topics:

• “About the Labware MiniHub” on page 2

• “Safety information” on page 4

• “Hardware overview” on page 4

• “Software overview” on page 8

• “Quick start” on page 11



1   Introduction
About the Labware MiniHub

2 G5584A Labware MiniHub User Guide

About the Labware MiniHub

Description

The Labware MiniHub is a rotating random- access labware storage device. Up 
to four labware can be placed on each shelf. Spacing blocks, also called 
spacers, can be added or removed to adjust the distance between shelves, 
accommodating different labware types (microplates, tip boxes, or tube racks).

The following options of the G5584A Labware MiniHub are available:

Option Description

BenchCel Configuration 
(option 010)

This option permits the following basic 
configurations:

• 10 shelves, with single spacers between 
shelves, accommodate a maximum of 
40 microplates

• 5 shelves, with two spacers between 
shelves, accommodate a maximum of 
20 deepwell microplates or tube racks

• 3 shelves, with three spacers between 
shelves, accommodate a maximum of 12 tip 
boxes

Other configurations can be created using 
different combinations of shelves and spacers.

The option is typically installed on risers, as 
the figure shows.

Integration Configuration 
(option 020)

BenchBot Robot

The Integration Configuration is for 
workstations or systems that have the 
BenchBot Robot or Direct Drive Robot (DDR).

For the BenchBot, this option enables the 
following basic configurations:

• 13 shelves, with single spacers between 
shelves, accommodate a maximum of 
52 microplates

• 7 shelves, with two spacers between 
shelves, accommodate a maximum of 
28 deepwell microplates or tube racks

• 5 shelves, with three spacers between 
shelves, accommodate a maximum of 20 tip 
boxes

Other configurations can be created using 
different combinations of shelves and spacers.
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Related information

Integration Configuration 
(option 020)

Direct Drive Robot

For the DDR, this option enables the following 
basic configurations:

• 16 shelves, with single spacers between 
shelves, accommodate a maximum of 
64 microplates

• 9 shelves, with two spacers between 
shelves, accommodate a maximum of 
36 deepwell microplates or tube racks

• 6 shelves, with three spacers between 
shelves, accommodate a maximum of 24 tip 
boxes

Other configurations can be created using 
different combinations of shelves and spacers.

Option Description

For information about... See...

Labware MiniHub safety G5584A Labware MiniHub Safety and 
Installation Guide

Preparing the lab for the Labware 
MiniHub installation

G5584A Labware MiniHub Safety and 
Installation Guide

Installing the Labware MiniHub G5584A Labware MiniHub Safety and 
Installation Guide

Hardware components “Hardware overview” on page 4

Software overview “Software overview” on page 8
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Safety information

Before you operate the Labware MiniHub, ensure you have read the following 
guides and are trained in the safe operation of the device.

• Automation Solutions Products General Safety Guide

• G5584A Labware MiniHub Safety and Installation Guide

Related information

Hardware overview

About this topic

This topic describes the following Labware MiniHub features:

• Main components

• Power supply

• Status lights

Main components

The following figure and table describe the main components of the Labware 
MiniHub.

For information about... See...

Safety precautions G5584A Labware MiniHub Safety and 
Installation Guide

Labware MiniHub description “About the Labware MiniHub” on 
page 2

Hardware components “Hardware overview” on page 4

Software overview “Software overview” on page 8



5

1   Introduction
Hardware overview

G5584A Labware MiniHub User Guide

Figure Main components: Integration Configuration (left) and BenchCel Configuration (right)

Labware MiniHub

Labware MiniHub

1

2

4

3

5

6

4

Item Name Description

1 Base White structure at the bottom of the MiniHub that 
attaches the MiniHub to the target surface. The base 
contains the electronics and hosts the connection panel 
and the indicator lights.

The base for the MiniHub BenchCel Configuration 
attaches to an integration- plate assembly (ikit) for 
integration with the BenchCel Microplate Handler.

2 Shelves Flat area on which you can place labware. Locating 
pins at the edges of the shelves hold the labware 
securely in place.

3 Spacers Metal spacing blocks that you can add or remove at the 
center of the MiniHub to adjust the distance between 
shelves.

Two types of spacers are available:

• 25.1- mm spacers. Stacked between shelves to 
accommodate different labware heights.

• 8.4- mm spacers. Stacked above the top- most shelf 
to fill the space between the top- most 25.1- mm 
spacer and the cassette cap. These spacers ensure 
a tight assembly and are only necessary when a 
subset of the shelves are used.

4 Cassettes Columns of shelves. The MiniHub consists of four 
cassettes, each identified by the number on the 
cassette cap. 

5 Cassette cap Metal label with numerical identification of each 
cassette. The numbers are used in Labware MiniHub 
Diagnostics and in VWorks software.
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Power supply

The power supply is the component that supplies electrical power to the 
Labware MiniHub.

Figure Power supply 

                                                         

6 Black knob Component at the top of the MiniHub that locks the 
spacers and shelves in place.

Item Name Description

1

2

3

Item Name Description

1 Labware MiniHub 
cable connector

Connects the Labware MiniHub to the power 
supply unit. 

2 Power inlet Connects the power supply unit to the power 
source. Use only the supplied power cord.

3 On/off switch Turns on (I) and off (o) the power supply.
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Status lights

On the base of the Labware MiniHub are two status lights, as the following 
figure shows.

Figure Status lights on Labware MiniHub base (front view)

 

Related information

Power Motor enabled
Motor disabled

Status light Description

Power Indicates whether the power is on or off:

• Green light is illuminated when the power is on. 

• Green light is off when the power is off.

Motor status Indicates whether the motor is enabled or disabled. 

• Red light indicates the motor is disabled. 

When you turn on the Labware MiniHub, the red light 
turns on.

• Green light indicates that the motor is enabled.

When you initialize the Labware MiniHub, the green light 
turns on.

For information about... See...

Labware MiniHub description “About the Labware MiniHub” on 
page 2

Labware MiniHub safety “Safety information” on page 4

Software overview “Software overview” on page 8
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Software overview

About this topic

This topic describes the software components you use to operate the Labware 
MiniHub:

• Labware MiniHub Diagnostics

• Laboratory automation software

Labware MiniHub Diagnostics

The following figure shows the Labware MiniHub Diagnostics dialog box.

The Labware MiniHub Diagnostics software allows you to:

• Create and manage profiles. A profile allows you to set up communication 
between the Labware MiniHub and the controlling computer, configure the 
Labware MiniHub (tell the software the number of shelves you are using), 
and set the rotation speed. For instructions, see “Creating Labware 
MiniHub profiles” on page 26.

• Set the home position. The home position is the starting position of the 
Labware MiniHub relative to the robot in the laboratory automation system 
or BenchCel Configuration. For instructions, see “Setting the home 
position” on page 32.
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• Diagnose problems. For information on diagnosing and troubleshooting 
problems, see “Using device diagnostics” on page 39 and “Maintenance and 
troubleshooting” on page 55.

Access to Labware MiniHub Diagnostics depends on the automation software 
you are using. 

Laboratory automation software

You can use either the VWorks software or third- party automation software to 
operate the Labware MiniHub in protocol runs. The Labware MiniHub ActiveX 
control permits third- party automation software to interface with the Labware 
MiniHub.

VWorks software
The following figure shows the VWorks window. 

The VWorks software allows you to:

• Set up the Labware MiniHub. During setup, you create a device file for the 
Labware MiniHub. For setup information, see “Setting up the device” on 
page 13.

• Set up user accounts and privileges. You can set up different user 
accounts to enforce access policies. For instructions, see the VWorks 
Automation Control Setup Guide.

• Define labware. Labware definitions describe the labware you will use 
during protocol runs. For instructions, see the VWorks Automation Control 
Setup Guide.

• Create protocols. Protocols determine the sequence of tasks you want to 
automate in a run. For example, you can use a protocol to unload 
60 microplates from the Labware MiniHub, apply barcode labels to the 
microplates, and then reload the microplates to the Labware MiniHub. For 
protocol- writing instructions, see the VWorks Automation Control User 
Guide.
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• Run, pause, monitor, and stop protocols. You can start, pause, monitor, 
and stop a protocol run from the controlling computer. For instructions, 
see the VWorks Automation Control User Guide.

For a full description and instructions on how to use the VWorks software, see 
the VWorks Automation Control User Guide.

Labware MiniHub ActiveX control
The Labware MiniHub ActiveX control allows automation control software 
other than the VWorks software to interface with the device. For more 
information, see “Labware MiniHub ActiveX control” on page 67.

Related information

For information about... See...

Labware MiniHub description “About the Labware MiniHub” on 
page 2

Labware MiniHub safety “Safety information” on page 4

Hardware components “Hardware overview” on page 4

Labware MiniHub ActiveX control “Labware MiniHub ActiveX control” on 
page 67
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Quick start

Overall setup workflow

The following table presents the basic steps for setting up the Labware 
MiniHub for operation.

Step For this task... See...

1 Prepare the lab for the Labware 
MiniHub installation.

G5584A Labware MiniHub Safety 
and Installation Guide

2 Install the Labware MiniHub. G5584A Labware MiniHub Safety 
and Installation Guide

3 Turn on the Labware MiniHub. “Turning on and off the Labware 
MiniHub” on page 15

4 Install the VWorks software, or 
integrate the MiniHub ActiveX 
control.

One of the following:

• VWorks Automation Control 
Setup Guide

• “Labware MiniHub ActiveX 
control” on page 67

5 VWorks software only. Start the 
VWorks software and log in.

VWorks Automation Control User 
Guide

6 VWorks software only. Create a 
new device file (if not already 
done).

“Creating a VWorks device file” on 
page 16

7 VWorks software only. Add the 
Labware MiniHub in the device 
file.

“Adding and deleting a Labware 
MiniHub in the device file” on 
page 18

8 Create a Labware MiniHub 
profile and set the profile 
parameters.

“Creating Labware MiniHub 
profiles” on page 26

9 Set the MiniHub home position. “Setting the home position” on 
page 32

10 Set robot teachpoints at the 
Labware MiniHub.

Both of the following:

• “Setting robot teachpoints” on 
page 37

• Automation system or robot 
user documentation

11 VWorks software only. Set the 
Labware MiniHub device 
properties.

“Setting Labware MiniHub 
properties” on page 19
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Related information

12 VWorks software only. Verify 
that the labware you plan to 
use is defined in the Labware 
Editor for the robot that you 
are using. 

BenchCel Configuration only. 
Ensure that the Stack holding 
method is set to Hold with stacker 
grippers to ensure precision 
performance.

VWorks Automation Control Setup 
Guide

13 VWorks software only. Ensure 
that MySQL 5.7 is installed on 
the computer, and that the 
database connection is enabled 
in the VWorks options.

VWorks Automation Control Setup 
Guide

14 Write and run protocols. One of the following:

• VWorks Automation Control 
User Guide

• Automation software user 
documentation

Step For this task... See...

For information about... See...

Labware MiniHub description “About the Labware MiniHub” on 
page 2

Labware MiniHub safety “Safety information” on page 4

Hardware components “Hardware overview” on page 4
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Setting up the device

This chapter explains how to set up the Labware MiniHub in the 
VWorks software. This chapter contains the following topics:

• “Setup workflow for the VWorks software” on page 14

• “Turning on and off the Labware MiniHub” on page 15

• “Creating a VWorks device file” on page 16

• “Adding and deleting a Labware MiniHub in the device file” on 
page 18

• “Setting Labware MiniHub properties” on page 19

If you are using a different lab automation software and want to 
integrate the Labware MiniHub using ActiveX control, see “Labware 
MiniHub ActiveX control” on page 67.
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Setup workflow for the VWorks software

The following table presents the steps for setting up the Labware MiniHub in 
the VWorks software. After setting up the Labware MiniHub for the first time, 
you will not likely need to change any of the settings in the procedure.

Step For this task... See...

1 Turn on the Labware MiniHub. “Turning on and off the Labware 
MiniHub” on page 15

2 Start the VWorks software and 
log in.

VWorks Automation Control User 
Guide

3 Create a device file. “Creating a VWorks device file” on 
page 16

4 Add the Labware MiniHub in 
the device file.

“Adding and deleting a Labware 
MiniHub in the device file” on 
page 18.

5 Set the Labware MiniHub 
properties in VWorks software.

“Setting Labware MiniHub 
properties” on page 19

6 Verify that the labware you 
plan to use is defined in the 
Labware Editor for the robot 
that you are using. 

BenchCel Configuration only. 
Ensure that the Stack holding 
method is set to Hold with stacker 
grippers to ensure precision 
performance.

VWorks Automation Control Setup 
Guide

7 Ensure that MySQL 5.7 is 
installed on the computer, and 
that the database connection 
is enabled in the VWorks 
options.

VWorks Automation Control Setup 
Guide
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Turning on and off the Labware MiniHub

Turning on the Labware MiniHub

To turn on the Labware MiniHub:

1 Ensure that the power supply is connected:

a The power supply cable connects to the 24V port (1) on the MiniHub 
base, as the following figure shows.

b The power cord connects to the AC power entry on the (2) power 
supply on one end and to a (3) power source with grounded circuit on 
the other end.

2 On the power supply, press the power switch to the on (I) position.

On the Labware MiniHub base, the green power light ( ) turns on.

Turning off the Labware MiniHub

To turn off the Labware MiniHub:

On the power supply, press the power switch to the off (o) position. On the 

Labware MiniHub base, the green power light ( ) turns off.
 

Related information

CAUTION The Labware MiniHub will rotate during the startup process. Obstructing the 
Labware MiniHub while it is rotating will cause an error.

LAN24V 2.5A

1

2

3

For information about... See...

Safety information G5584A Labware MiniHub Safety and 
Installation Guide
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Creating a VWorks device file

About this topic

This topic explains how to create a device file in the VWorks software. If you 
already have a VWorks device file you want to use, skip this step and proceed 
to “Adding and deleting a Labware MiniHub in the device file” on page 18.

Devices and device file defined

What is a device?
A device is an item in your lab automation system that has an entry in the 
VWorks device file. A device can be a robot, an instrument, or a location in the 
system that can hold a piece of labware. The following are some examples of 
devices:

• Automation system robot, such as the Direct Drive Robot

• BenchCel robot

• Labware MiniHub

• PlateLoc Thermal Microplate Sealer

• Microplate Labeler

• Bravo Platform

• Platepad

What is a device file?
To communicate with and to control the robot and integrated devices, the 
VWorks software uses a device file that contains the following information:

• List of devices the software will communicate with and control

• Profile of each device (communication method, unique device configuration 
information)

• System- related configuration information of each device (for example, 
approach height, barcode access, and so on)

You provide the device information in the VWorks software. The device 
information is stored in a device (.dev) file that is located in a folder you 
specify when saving the file, for example, C:\VWorks Workspace\Device Files.

For detailed information about device files and associations with profiles, 
teachpoint files, and other VWorks components, see the VWorks Automation 
Control User Guide.

Adding the Labware MiniHub in 
the device file

“Adding and deleting a Labware 
MiniHub in the device file” on page 18

Creating profiles for the MiniHub “Creating Labware MiniHub profiles” on 
page 26

Setting teachpoints “Setting robot teachpoints” on page 37

For information about... See...
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Procedure

If you are setting up a lab automation system, such as a BenchCel Workstation, 
for the first time, you need to create a new device file, and then add the 
system or workstation robot, the Labware MiniHub, and other integrated 
devices to this file.

Before you create a device file, start the VWorks software and log in. See the 
VWorks Automation Control User Guide for instructions.

To create a new device file:

1 In the VWorks window, select File > New > Device. A Device File tab appears.

2 Select File > Save to save the device file. The file name appears in the 
Device File tab.

Related information

For information about... See...

VWorks software • VWorks Automation Control Setup 
Guide

• VWorks Automation Control User 
Guide

Adding the Labware MiniHub in 
the device file

“Adding and deleting a Labware 
MiniHub in the device file” on page 18

Creating profiles for the MiniHub “Creating Labware MiniHub profiles” on 
page 26

Setting teachpoints “Setting robot teachpoints” on page 37
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Adding and deleting a Labware MiniHub in the device file 

Adding a Labware MiniHub in the device file

To add a Labware MiniHub in the device file:

1 In the Available Devices area, double- click the Labware MiniHub device icon. 
Alternatively, you can drag the icon from the Available Devices area into the 
Device File area.

Notice that in the Devices area, the first Labware MiniHub device is labeled 
Labware MiniHub- 1. If you add another Labware MiniHub device, it will 
appear as Labware MiniHub- 2.

If you do not see the Labware MiniHub in the Available Devices list, check 
that the MiniHub plugin file (AgilentLabwareMiniHub.dll) is stored in the 
following folder: ...\Agilent Technologies\VWorks\Plugins.

If you added the Labware MiniHub plugin file in the Plugins folder and you 
have already started the VWorks software, be sure to reload the plugin. To 
do this, close any open device files and protocol files, and then select 
Tools > Reload Plugins.

2 If you have multiple Labware MiniHub devices in the system, repeat step 1 
to add the other Labware MiniHub devices.

Deleting a Labware MiniHub from the device file

To delete a Labware MiniHub from the device file:

1 In the VWorks window, select the Labware MiniHub you want to delete in 
the Devices area.

2 Click Delete selected devices.
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Related information

Setting Labware MiniHub properties 

About the Labware MiniHub properties

In the device file, you can set properties for each device. For the Labware 
MiniHub, you can name the Labware MiniHub, select the desired profile, and 
associate the robot teachpoint with each shelf.

The instructions in this topic assume that you have already:

For information about... See...

Creating profiles for the Labware 
MiniHub

“Creating Labware MiniHub profiles” on 
page 26

Editing profiles “Editing and managing profiles” on 
page 29

Setting up Labware MiniHub 
properties in the device file

“Setting Labware MiniHub properties” 
on page 19

VWorks software • VWorks Automation Control Setup 
Guide

• VWorks Automation Control User 
Guide
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• Created a Labware MiniHub profile.

• Set the Labware MiniHub home position.

• Set the robot teachpoints for each shelf.

Procedure

To set the Labware MiniHub properties:

1 In the Labware MiniHub Properties area of the device file, type or select the 
following:

2 In the Devices area, expand Labware MiniHub, and then select Slot 1.

3 In the Labware MiniHub Location Properties area, set the following parameters:

Property Description

Name The name of the Labware MiniHub.

Profile The profile associated with the device.

Select the desired profile from the list. If the profile 
you want does not appear in the list, or if no 
profile appears in the list, see “Creating Labware 
MiniHub profiles” on page 26, and then return to 
this step to select the profile.

IMPORTANT Without the profile, you will not be 
able to establish communication with the device.
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Parameter Description

Allow/prohibited labware Permitted labware class for the selected 
location.

For example, you might specify that 
only tip boxes are allowed at a given 
location. For details on labware classes, 
see the VWorks Automation Control 
Setup Guide.

BCR on south/west/north/east 
side

The location of the barcode reader and 
the desired barcode reader device.

Use this field only if a barcode reader 
is installed on the device.

Teachpoint for robot 
<robot_name>

The name of the teachpoint at the 
selected Slot location. This selection 
enables the robot to move correctly to 
and from the Slot location during a 
protocol run.

If the robot teachpoint file contains a 
teachpoint for this slot, you must select 
that teachpoint.

Note: In simulation mode, select 
<accessible>.
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4 Repeat steps 2 and 3 to set the properties for the remaining slots.

5 Select File > Save to save the device file.

6 In the Device File area, select the Labware MiniHub, and then click Initialize 
selected devices to establish communication with the device.

Related information

Use for deadlock avoidance The option to permit the location to be 
used for deadlock avoidance.

Select Yes to permit labware to be 
moved to this location to avoid a 
deadlock in the system.

Select No if you do not want to move 
random labware to this location to 
avoid deadlock.

IMPORTANT For typical operation, 
select No for the Labware MiniHub.

Door Not applicable

Parameter Description

For information about... See...

Creating profiles for the Labware 
MiniHub

“Creating Labware MiniHub profiles” on 
page 26

Editing profiles “Editing and managing profiles” on 
page 29

VWorks software • VWorks Automation Control Setup 
Guide

• VWorks Automation Control User 
Guide
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Configuring profiles and setting 
teachpoints

This chapter contains the following topics:

• “Configuration workflow” on page 24

• “Opening Labware MiniHub Diagnostics” on page 25

• “Creating Labware MiniHub profiles” on page 26

• “Editing and managing profiles” on page 29

• “Initializing the Labware MiniHub” on page 30

• “Setting the home position” on page 32

• “Setting robot teachpoints” on page 37
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Configuration workflow

About this topic

This topic presents the workflow for configuring the Labware MiniHub in 
Labware MiniHub Diagnostics. This step is required whether you are using the 
VWorks software or a different automation control software with the Labware 
MiniHub ActiveX control.

Workflow

The following table presents the steps for setting up the Labware MiniHub in 
Labware MiniHub Diagnostics.

Step For this task... See...

1 Create a profile for the 
Labware MiniHub.

“Creating Labware MiniHub 
profiles” on page 26

2 Edit or rename the profile. “Editing and managing profiles” on 
page 29

3 Set the Labware MiniHub 
home position.

“Setting the home position” on 
page 32

4 Set robot teachpoints. “Setting robot teachpoints” on 
page 37
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Opening Labware MiniHub Diagnostics

About this topic

Access to Labware MiniHub Diagnostics depends on the automation software 
you are using: VWorks software or third- party automation software.

VWorks software

In the VWorks software Devices area, select the Labware MiniHub name, and 
then click Device diagnostics.

Third-party automation control software

To open Labware MiniHub Diagnostics using Labware MiniHub ActiveX control, 
call the ShowDiagsDialog method. For details, see “Labware MiniHub ActiveX 
control” on page 67.

Related information

For information about... See...

Creating profiles “Creating Labware MiniHub profiles” on 
page 26

Setting the home position “Setting the home position” on page 32

Setting robot teachpoints “Setting robot teachpoints” on page 37

Configuring the MiniHub “Configuration workflow” on page 24
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Creating Labware MiniHub profiles 

About profiles

A VWorks device profile is a collection of settings that manages how you 
connect to a device. A Labware MiniHub profile specifies the following:

• IP address used to establish LAN communication between the device and 
the controlling computer.

• Number of shelves (or slots) in each Labware MiniHub cassette.

You use the Labware MiniHub Diagnostics software to create and manage 
Labware MiniHub profiles.

Note: If you are using the VWorks software, be aware that each device in the 
device file requires a unique profile. For information about device files, see 
“Creating a VWorks device file” on page 16. For a detailed description of the 
relationships between the device file and profile, see the VWorks Automation 
Control User Guide.

Creating a Labware MiniHub profile 

To create a Labware MiniHub profile:

1 Open Labware MiniHub Diagnostics.

2 In the Labware MiniHub Diagnostics dialog box, click the Profiles tab.

3 In the Profile Management area, click Create a new profile. The Create Profile 
dialog box opens.

4 In the Create Profile dialog box, type a name for the new profile, and click 
OK. The name appears in the Profile name list.

Note: If this computer controls multiple Labware MiniHub devices, 
identify the device in the profile name, for example, the device serial 
number.
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5 Under Connection, select This MiniHub is connected via ethernet, and then click 
Find available device. 

Note: If you have an earlier model device, you may select This MiniHub is 
connected via serial, and then select which COM port on the computer you 
are using. 

6 In the Discovered BioNet Devices dialog box that opens:

a Click the Select the Ethernet adapter to use from the list below list, and select 
the correct adapter for the device connection.

b In the list of devices that appear, select the MiniHub device. If multiple 
MiniHub devices are on the network, use the MAC Address to identify 
the MiniHub device for this profile. To successfully communicate with 
the MiniHub device, the Status column must display New or Matched.

c Click OK.

7 In the Other Profile Settings area, set the following parameters:

Profile parameter Description

Slots Per Cassette The number of shelves in each cassette. (A 
cassette is a column of shelves. The Labware 
MiniHub consists of four cassettes.)

The maximum number of slots possible 
depends on the Labware MiniHub model:

• The BenchCel Configuration has a 
maximum of 10 slots.

• The Integration Configuration has a 
maximum of 16 slots.

The DDR can access up to 16 slots.

The BenchBot can access up to 13 slots.
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8 Click Update this profile to save the changes.

9 Click Initialize this profile to establish communication with the Labware 
MiniHub.

Related information

Speed The speed at which the Labware MiniHub 
rotates during protocol runs. The three 
selections are:

• Slow. Turns the MiniHub at 25% of the 
factory- set maximum speed.

• Medium. Turns the MiniHub at 50% of 
the factory- set maximum speed.

• Fast. Turns the MiniHub at 100% of the 
factory- set maximum speed.

Profile parameter Description

CAUTION The Labware MiniHub will rotate during the initialization process. 
Obstructing the Labware MiniHub while it is rotating will cause an error.

For information about... See...

Editing and managing profiles “Editing and managing profiles” on 
page 29

Setting the home position “Setting the home position” on page 32

Setting robot teachpoints “Setting robot teachpoints” on page 37

Configuring the MiniHub “Configuration workflow” on page 24
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Editing and managing profiles

About this topic

This topic assumes that you have opened Labware MiniHub Diagnostics.

Editing profiles

To edit a profile:

1 In the Profiles tab, select the profile you want to edit in the Profile 
Management area.

2 Modify the profile information.

Note: Changes you make in the profile are shown in the table below the 
Profile Settings area. In addition, the changes are shown in the log area 
at the bottom of the dialog box.

3 When you are finished, click Update this profile to save the changes.

Managing profiles

In the Profiles tab, you can select an existing profile, and then rename, copy, or 
delete the profile.

CAUTION A copy of an existing profile references the same home position. 
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Related information

Initializing the Labware MiniHub

About this topic

To establish communication between the computer and the Labware MiniHub, 
you initialize the MiniHub device. You can initialize the Labware MiniHub in 
the following ways:

• Labware MiniHub Diagnostics. To control the Labware MiniHub using 
Labware MiniHub Diagnostics, initialize the profile in Labware MiniHub 
Diagnostics.

• VWorks window. To control the Labware MiniHub from the VWorks 
window, for example, to run a protocol, initialize the device in the VWorks 
window. For instructions, see the VWorks Automation Control User Guide.

Initializing the device in diagnostics

To initialize the device in diagnostics:

1 Open Labware MiniHub Diagnostics. For instructions, see “Opening 
Labware MiniHub Diagnostics” on page 25.

2 In the Profiles tab, select the profile, and then click Initialize this profile.

For information about... See...

Creating profiles “Creating Labware MiniHub profiles” on 
page 26

Setting the home position “Setting the home position” on page 32

Setting robot teachpoints “Setting robot teachpoints” on page 37

Configuring the MiniHub “Configuration workflow” on page 24

CAUTION The Labware MiniHub will rotate during the initialization process. 
Obstructing the Labware MiniHub while it is rotating will cause an error.
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If you are using the Labware MiniHub ActiveX control, see “Labware MiniHub 
ActiveX control” on page 67.

Related information

For information about... See...

Creating profiles “Creating Labware MiniHub profiles” on 
page 26

Setting the home position “Setting the home position” on page 32

Setting robot teachpoints “Setting robot teachpoints” on page 37

Configuring the MiniHub “Configuration workflow” on page 24
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Setting the home position

About the home position

The Labware MiniHub home position is the position at which the automation 
robot accesses any slot in cassette 1. Cassette 1 is identified by the number 1 
on the cassette cap.

When the MiniHub is in the home position, the Position value in the Controls 
tab is set at 0.0.
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Before you start

Make sure you do the following:

• BenchCel Configuration. Load the labware you want to use in one of the 
stackers, and then downstack a labware. The BenchCel robot should be 
holding the labware.

• Integration Configuration. Use the robot (BenchBot or DDR) to pick up 
the teaching jig or microplate from a platepad. The robot should be holding 
the teaching jig or microplate.

Procedure

To set the Labware MiniHub home position:

1 Disable the robot (BenchCel, BenchBot Robot, or DDR) so that you can 
manually move the robot arm. 

For instructions, see the corresponding robot user guide, for example, the 
BenchCel Microplate Handler User Guide.

Note: For the DDR and BenchBot, the robot must to be in Teach mode.

2 In Labware MiniHub Diagnostics, click the Controls tab, and then click Disable 
in the Motor area. You should be able to manually rotate the Labware 
MiniHub.
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3 Manually rotate the MiniHub so that cassette 1 faces the robot. This is the 
approximate home position.

In the following figures, notice that cassette 1 is facing the robot.

Figure BenchCel Microplate Handler integrated with MiniHub (top view)

Figure Direct Drive Robot integrated with the MiniHub (top view)

4 Move the robot so that the microplate held in the gripper sits in MiniHub 
shelf 1, the bottom- most shelf, in cassette 1.

Note: You can place the microplate in any cassette- 1 shelf. However, 
because you will need to set a robot teachpoint at each shelf later, it is 
convenient to start with shelf 1 in this procedure.

                                                        

1

2
3

4
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5 Check the position of the microplate. You might have to rotate the Labware 
MiniHub slightly or move the robot arm until the microplate is seated 
correctly in the slot.

If the microplate is seated at a slight angle to the shelf, rotate the Labware 
MiniHub slightly to adjust the microplate position.

BenchCel Configuration only. If the microplate is sitting too far forward or 
backward, and adjusting the BenchCel robot and MiniHub manually do not 
solve the problem, unlock the MiniHub integration plate. Move the 
MiniHub- integration plate assembly forward or backward until the 
microplate is seated correctly in the slot.

6 In the Controls tab:

a Click Enable under Motor to re- enable the motor.

b Click Teach Home. Notice that the Position value is set at 0.0.
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7 In the Profiles tab, click Update this profile to save the change.

8 Leave the labware and robot in their current position and proceed to set 
the robot teachpoints.

Related information

For information about... See...

Creating profiles “Creating Labware MiniHub profiles” on 
page 26

Editing and managing profiles “Editing and managing profiles” on 
page 29

Setting robot teachpoints “Setting robot teachpoints” on page 37

Configuring the MiniHub “Configuration workflow” on page 24
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Setting robot teachpoints

About setting robot teachpoints

After setting the Labware MiniHub home position, you set the robot 
teachpoints at each shelf in cassette 1. To set, edit, and verify robot 
teachpoints, see the robot user guide, for example, the BenchCel Microplate 
Handler User Guide.

Note: You only need to set teachpoints at all of the shelves in cassette 1. The 
software will reference these teachpoints when accessing shelves in cassettes 2, 
3, and 4.

IMPORTANT Before setting the robot teachpoints, make sure the Labware 
MiniHub motor is enabled. For instructions, see “Enabling and disabling the 
motor” on page 43. In addition, make sure the Labware MiniHub is at its home 
position. For instructions, see “Rotating the MiniHub to a specific position” on 
page 47.

BenchCel Configuration only. Ensure that the labware definitions specify that 
the Stack holding method is set to Hold with stacker grippers to ensure precision 
performance.

If you used shelf 1 to set the home position, you can go ahead and set the 
robot teachpoint at shelf 1 while you have the robot and microplate in 
position.

About the approach height

IMPORTANT For each teachpoint, set the approach height such that it is 
greater than the height of the locating pins on the MiniHub shelf and less than 
the shelf directly above. For example, the locating pins are 5.1 mm tall, so the 
minimum approach height should be 6 mm if single spacers are used between 
shelves.

Figure Approach height considerations at each shelf (side view)

About verifying teachpoints

Ensure that you verify the robot teachpoints at the Labware MiniHub before 
you use the Labware MiniHub. For instructions, see the applicable robot user 
guide, for example, the BenchCel Microplate Handler User Guide.

5.1 mm 6.0 mm
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Related information

For information about... See...

Labware specifications G5584A Labware MiniHub Safety and 
Installation Guide

Creating profiles “Creating Labware MiniHub profiles” on 
page 26

Editing and managing profiles “Editing and managing profiles” on 
page 29

Setting the home position “Setting the home position” on page 32

Configuring the MiniHub “Configuration workflow” on page 24
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4
Using device diagnostics

This chapter explains how to use the provided software tools to 
diagnose and troubleshoot the Labware MiniHub.

This chapter contains the following topics:

• “About Labware MiniHub Diagnostics” on page 40

• “Checking the current position of the device” on page 41

• “Enabling and disabling the motor” on page 43

• “Changing the rotation speed” on page 45

• “Rotating the MiniHub to a specific position” on page 47

• “Checking the fault indicator” on page 52

• “Viewing the log area” on page 53

Note: See “Quick reference” on page 61 for an overview of Labware 
MiniHub Diagnostics.
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About Labware MiniHub Diagnostics 

The Labware MiniHub Diagnostics software allows you to create profiles and 
control the motions of the Labware MiniHub. The software has two tabs: 
Controls and Profiles. The commands and parameters available in the Controls 
tab can help you troubleshoot problems.

Related information

For information about... See...

Opening Labware MiniHub 
Diagnostics

“Opening Labware MiniHub Diagnostics” 
on page 25

Checking the Labware MiniHub’s 
current position

“Checking the current position of the 
device” on page 41

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 43

Changing the rotation speed “Changing the rotation speed” on 
page 45 
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Checking the current position of the device

Procedure

To check the current position of the MiniHub:

1 If you have not already done so, open diagnostics. For instructions, see 
“Opening Labware MiniHub Diagnostics” on page 25.

2 In the Controls tab, check the values in the Cassette and Position boxes.

Rotating to a specific position “Rotating the MiniHub to a specific 
position” on page 47

Teaching the home position “Setting the home position” on page 32

The fault indicator “Checking the fault indicator” on 
page 52

Viewing the log area “Viewing the log area” on page 53

Profiles tab “Creating Labware MiniHub profiles” on 
page 26

For information about... See...



4   Using device diagnostics
Checking the current position of the device

42 G5584A Labware MiniHub User Guide

• Cassette. Indicates the cassette that is currently facing the robot. For 
example, a Cassette value of 3 indicates that cassette 3 is facing the robot. 
A dash (—) indicates that the Labware MiniHub is between cassette 
positions.

• Position. Indicates the position of the Labware MiniHub relative to its home 
position. Position values range from 0–360°, counterclockwise from the 
home position. 

The Cassette values correspond to the following Position values:

If the Labware MiniHub is between cassette positions, other position values 
will be displayed. For example, if the Labware MiniHub is exactly between 
cassette 1 (0°) and cassette 2 (90°), the Position value is 45°.

Related information

Cassette Position value

1 (home) 0°

2 90°

3 180°

4 270°

1

2
3

4
0°

90°

180°

270°

For information about... See...

Opening Labware MiniHub 
Diagnostics

“Opening Labware MiniHub Diagnostics” 
on page 25

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 43

Changing the rotation speed “Changing the rotation speed” on 
page 45 
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Enabling and disabling the motor

About this topic

Disabling the MiniHub motor allows you to rotate the Labware MiniHub by 
hand. You might want to do this when you:

• Set the home position.

• Want to remove labware from specific shelves after a run error occurs.

After setting the home position or fixing the error, you can enable the Labware 
MiniHub motor to resume operation.

Procedure

To disable the Labware MiniHub motor:
In the Controls tab, click Disable. In the Motor area, the green Enabled light turns 
off.

On the MiniHub base, the motor status light turns red.

To enable the Labware MiniHub motor:
In the Controls tab, click Enable. In the Motor area, the green Enabled light turns 
on. 

On the MiniHub base, the motor status light turns green.

Rotating to a specific position “Rotating the MiniHub to a specific 
position” on page 47

Teaching the home position “Setting the home position” on page 32

The fault indicator “Checking the fault indicator” on 
page 52

Viewing the log area “Viewing the log area” on page 53

Profiles tab “Creating Labware MiniHub profiles” on 
page 26

For information about... See...

CAUTION The Labware MiniHub might rotate slightly when you enable the motor. 
Obstructing the Labware MiniHub while it is rotating will cause an error.
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Figure Motor area in the Controls tab

Figure Status lights on Labware MiniHub base (front view)

Related information

Power Motor enabled
Motor disabled

For information about... See...

Opening diagnostics “Opening Labware MiniHub Diagnostics” 
on page 25

Checking the Labware MiniHub’s 
current position

“Checking the current position of the 
device” on page 41

Changing the rotation speed “Changing the rotation speed” on page 45 

Rotating to a specific position “Rotating the MiniHub to a specific 
position” on page 47

Teaching the home position “Setting the home position” on page 32

The fault indicator “Checking the fault indicator” on page 52

Viewing the log area “Viewing the log area” on page 53
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Changing the rotation speed

About this topic

You can select the speed at which the Labware MiniHub turns while you are 
making adjustments in Labware MiniHub Diagnostics. For example, you can 
select the Slow speed when you are setting up or troubleshooting the Labware 
MiniHub.

Note: To set the rotation speed for protocol runs, use the Speed selection in 
the Profiles tab.

Procedure

To select the diagnostic rotation speed:

1 If you have not already done so, open diagnostics. See “Opening Labware 
MiniHub Diagnostics” on page 25.

2 In the Controls tab, select one of the following speeds from the Speed list:

Speed Description

Slow Rotates the MiniHub at 25% of the factory- set 
maximum speed.

Medium Rotates the MiniHub at 50% of the factory- set 
maximum speed.

Fast Rotates the MiniHub at 100% of the factory- set 
maximum speed.
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Related information

For information about... See...

Opening Labware MiniHub 
Diagnostics

“Opening Labware MiniHub Diagnostics” 
on page 25

Checking the current position of 
the Labware MiniHub

“Checking the current position of the 
device” on page 41

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 43

Rotating to a specific position “Rotating the MiniHub to a specific 
position” on page 47

Teaching the home position “Setting the home position” on page 32

The fault indicator “Checking the fault indicator” on 
page 52

Viewing the log area “Viewing the log area” on page 53
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Rotating the MiniHub to a specific position

About this topic

You can use Labware MiniHub Diagnostics to rotate the MiniHub using one of 
the following methods:

• Rotating to a specific cassette

• Rotating the Labware MiniHub in set increments

• Rotating the MiniHub to a specific position relative to home

For instructions on how to open diagnostics, see “Opening Labware MiniHub 
Diagnostics” on page 25.

Rotating to a specific cassette

You can rotate the Labware MiniHub so that the desired cassette is facing the 
robot.

To rotate to a specific cassette:

1 Move the automation robot away from the Labware MiniHub. For 
instructions, see the applicable robot user guide, for example, the BenchCel 
Microplate Handler User Guide.

2 In the Controls tab, select the desired cassette from the Rotate to cassette list, 
and then click Rotate to cassette. The Labware MiniHub rotates until the 
desired cassette faces the robot. The Cassette box displays the current 
cassette position.

Profiles tab “Creating Labware MiniHub profiles” on 
page 26

For information about... See...

CAUTION Obstructing the Labware MiniHub while it is rotating will cause an error. 
Remove any obstacle that might prevent the Labware MiniHub from rotating.
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Rotating the Labware MiniHub in set increments

You can rotate the Labware MiniHub clockwise or counterclockwise in set 
increments from its current position.

To rotate the Labware MiniHub in set increments:

1 Move the automation robot away from the Labware MiniHub. For 
instructions, see the applicable robot user guide, for example, the BenchCel 
Microplate Handler User Guide.

2 In the Controls tab, under Movement, click the arrow on the right of either 
Jog button, and then click the jog increment (degrees): 1, 5, 30, 45, 90, or 
180.

3 Click the Jog button to jog the Labware MiniHub in the corresponding 
direction:

Command Description

Jog 
counterclockwise

Rotates the MiniHub counterclockwise by the displayed 
degrees relative to its current position. 

Jog clockwise Rotates the MiniHub clockwise by the displayed 
degrees relative to its current position. 
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4 Click the Jog counterclockwise or Jog clockwise button again to rotate the 
MiniHub the specified number of degrees.

Rotating the MiniHub to a specific position relative to home

You can rotate the stage so that cassette 1 is at a specified number of degrees 
from the home position, 0°.

To rotate the MiniHub a specific number of degrees:

1 Move the automation robot away from the Labware MiniHub. For 
instructions, see the applicable robot user guide, for example, the BenchCel 
Microplate Handler User Guide.

2 In the Controls tab, type the number of degrees in the Rotate to degree box, 
and then click Rotate to degree. 

If you specified an angle between 1° and 180°, the software will rotate the 
Labware MiniHub clockwise. If you specified an angle greater 180°, the 
software will rotate the Labware MiniHub counterclockwise.
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Related information

For information about... See...

Opening Labware MiniHub 
Diagnostics

“Opening Labware MiniHub Diagnostics” 
on page 25

Checking the current position of 
the Labware MiniHub

“Checking the current position of the 
device” on page 41

Changing the rotation speed “Changing the rotation speed” on 
page 45 

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 43

Teaching the home position “Setting the home position” on page 32

The fault indicator “Checking the fault indicator” on 
page 52

Viewing the log area “Viewing the log area” on page 53

Profiles tab “Creating Labware MiniHub profiles” on 
page 26
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Checking the fault indicator

About controller faults

If an error occurs during operation, the red Fault light turns on in the 
Controls tab in Labware MiniHub Diagnostics.

Read the message in the error dialog box, and then check “Maintenance and 
troubleshooting” on page 55 for actions you can take to resolve the error. After 
the error is resolved, the Fault light in the Labware MiniHub Diagnostics dialog 
box turns off.

Related information

For information about... See...

Opening Labware MiniHub 
Diagnostics

“Opening Labware MiniHub Diagnostics” 
on page 25

Viewing the log area “Viewing the log area” on page 53



53

4   Using device diagnostics
Viewing the log area

G5584A Labware MiniHub User Guide

Viewing the log area

About the log area

The log area displays all of the commands issued and the status of the actions 
while you are working in the dialog box. Error conditions are displayed in red 
text.

If the Labware MiniHub is integrated in the VWorks software, the information 
displayed in the log area is also written to the VWorks log file.

Profiles tab “Creating Labware MiniHub profiles” on 
page 26

For information about... See...
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Related information

For information about... See...

Opening Labware MiniHub 
Diagnostics

“Opening Labware MiniHub Diagnostics” 
on page 25

Checking the current position of 
the Labware MiniHub

“Checking the current position of the 
device” on page 41

Enabling and disabling the 
MiniHub motor

“Enabling and disabling the motor” on 
page 43

Clearing controller faults “Checking the fault indicator” on 
page 52
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5
Maintenance and troubleshooting

This chapter describes how to maintain the Labware MiniHub and 
how to troubleshoot potential problems. This chapter contains the 
following topics:

• “Cleaning the shelves” on page 56

• “Troubleshooting hardware problems” on page 56

• “Troubleshooting error messages” on page 58

• “Reporting problems” on page 60
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Cleaning the shelves

Procedure

Be sure to clean up spills on any part of the Labware MiniHub immediately 
after a protocol run. Use a clean soft cloth to remove the spill. Use clean 
water or an alcohol- based cleaning solution to remove dirt. Do not use 
corrosive cleaning solutions.

Related information

Troubleshooting hardware problems

About this topic

This topic lists commonly encountered hardware problems, the causes of the 
problems, and ways to resolve the problems:

• “Communication or power problems” on page 57

• “Homing and other problems” on page 57

If you are still experiencing problems with the Labware MiniHub after trying 
the solutions, contact Agilent Automation Solutions Technical Support.

WARNING  Always turn off the Labware MiniHub and shut down the lab automation 
system or workstation before performing any maintenance procedure. See “Turning on and 
off the Labware MiniHub” on page 15 and the lab automation system user documentation.

For information about... See...

Safety information G5584A Labware MiniHub Safety and 
Installation Guide

Reporting problems “Reporting problems” on page 60
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Communication or power problems

Homing and other problems

Problem Cause Solution

The Labware 
MiniHub does not 
turn on.

The electrical requirements are not 
met.

Make sure the electrical requirements are 
met. See the G5584A Labware MiniHub 
Safety and Installation Guide.

The power supply on/off switch is 
set to the off (o) position, or the 
Labware MiniHub is not connected 
to the power supply or the power 
source.

Verify that the Labware MiniHub power 
supply on/off switch is set to on (I) and 
that the power supply is connected 
properly. See “Turning on and off the 
Labware MiniHub” on page 15.

The power light is 
on, but the 
Labware MiniHub 
does not rotate.

The Labware MiniHub is not 
initialized.

In the Labware MiniHub Diagnostics 
Profiles tab, make sure the correct profile 
is initialized, and that the profile specifies 
the correct device ID. For details, see 
“Creating Labware MiniHub profiles” on 
page 26.

The Labware MiniHub is not 
connected to the controlling 
computer.

Make sure the Ethernet cable and 
connections to the computer are secure 
and in good condition.

Either an error occurred or the 
motor is disabled. An obstruction 
may be preventing the Labware 
MiniHub from rotating.

Check the motor status light on the base. 
See “Status lights” on page 7. 

• If the motor status light is red:

Remove any obstacles in the path of 
the Labware MiniHub.

Re- enable the motor using Labware 
MiniHub Diagnostics. See “Enabling 
and disabling the motor” on page 43.

• If the motor status light is green, see 
“Checking the fault indicator” on 
page 52.

Problem Cause Solution

The Labware 
MiniHub does not 
home.

The home position is set 
incorrectly.

Reset the home position and try again. 
See “Setting the home position” on 
page 32.

The encoder might be dirty or 
damaged.

Contact Agilent Automation Solutions 
Technical Support.

A communication error might have 
occurred.

Make sure the Ethernet cable and 
connections to the computer are secure 
and in good condition.
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Related information

Troubleshooting error messages

About this topic

The following tables list commonly encountered error messages, the causes of 
the errors, and ways to resolve the errors. 

If you are still experiencing problems with the Labware MiniHub after trying 
the solutions, or if an error not on the list is displayed, contact Agilent 
Automation Solutions Technical Support.

For protocol- related errors, see the applicable automation control software 
user guide, such as the VWorks Automation Control User Guide.

Communication errors

The following error messages are caused by communication problems:

• The command timed out.

• Attempted to communicate without being connected, please connect and 
retry the operation.

• Failed to connect.

• TCP connection has not been established.

The robot does 
not place or pick 
labware correctly 
at the Labware 
MiniHub.

The robot teachpoints might be set 
incorrectly, the Labware MiniHub 
has moved after the teachpoints 
were set, or the shelves are bent.

Check and reset the robot teachpoints. 
See “Setting robot teachpoints” on 
page 37.

Check for and replace bent shelves.

The Labware 
MiniHub has 
stopped and the 
motor status light 
on the base is 
red.

The motor is disabled, possibly 
because an obstacle prevented the 
Labware MiniHub from rotating.

Remove the obstacle, click Retry, and 
resume operation.

Reinitialize the Labware MiniHub. If the 
problem persists, power cycle the device.

Problem Cause Solution

For information about... See...

Labware MiniHub components “Hardware overview” on page 4

Hardware problems “Troubleshooting hardware problems” 
on page 56

Reporting problems “Reporting problems” on page 60
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Check the following causes and try the corresponding solutions:

Motor control errors

The following error messages are typically caused by an obstacle in the path of 
the Labware MiniHub rotation.

• Axis timed out during commutation.

• Axis timed out during homing.

• Homing failed and the number of retries has been exceeded.

• Motor has gone over I2T current limit either by a spike or for a length of 
time.

• Move timed out.

• Position is outside its limit range.

Check the following causes and try the corresponding solutions:

Related information

Cause Solution

The Ethernet cable is not connected 
properly.

Verify that the Ethernet cable is in good condition and 
securely connected.

Power cycle the device, and try to reconnect.

The device profile specifies the wrong 
device ID for this Labware MiniHub.

Verify that the device profile specifies the correct device 
ID. See “Creating Labware MiniHub profiles” on page 26.

Reinitialize the profile. If the problem persists, power cycle 
the device.

Cause Solution

An obstacle outside the Labware 
MiniHub is preventing it from rotating.

Remove any obstacles that are preventing the Labware 
MiniHub from rotating.

Try rotating the Labware MiniHub again.

The labware is not properly seated in 
the alignment features of the shelves 
and is preventing the Labware 
MiniHub from rotating.

The robot teachpoints might be set 
incorrectly, the Labware MiniHub has 
moved after the teachpoints were set, 
or the shelves are bent.

Verify that all labware are properly seated within the 
alignment features of their respective shelves.

Check for and replace bent shelves.

Check the robot teachpoints at the Labware MiniHub to 
ensure that the robot is placing the labware in the shelves 
correctly. See “Setting robot teachpoints” on page 37.

Retry the operation. 

For information about... See...

Labware MiniHub component 
names

“Hardware overview” on page 4

Hardware problems “Troubleshooting hardware problems” 
on page 56
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Reporting problems

Contacting Automation Solutions Technical Support 

If you find a problem with the Labware MiniHub, contact Agilent Automation 
Solutions Technical Support. For contact information, see Notices on the back 
of the title page. 

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the device ready. You can locate the serial number on the base.

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Relevant software version number (for example, automation control 
software, diagnostics software, ActiveX control software, and firmware)

• Error message text (or screen capture of the error message dialog box)

• Relevant files, such as log files

Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments in an email to 
documentation.automation@agilent.com.
 

Related information

Reporting problems “Reporting problems” on page 60

For information about... See...

For information about... See...

Troubleshooting hardware 
problems

“Troubleshooting hardware problems” 
on page 56

Software error messages “Troubleshooting error messages” on 
page 58

mailto:documentation.automation@agilent.com
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A
Quick reference

This appendix contains the following topics:

• “Profiles tab” on page 62

• “Controls tab” on page 65
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Profiles tab

Profile Management area

Control Description

Profile name Displays the selected profile. Also allows you 
to select from the list of available profiles.

Create a new profile Creates a new profile.

Create a copy of this profile Creates a duplicate copy of the selected 
profile.

Rename this profile Renames the selected profile.

Delete this profile Deletes the selected profile.

Update this profile Saves changes to the selected profile.

Initialize this profile Initiates communication with the device using 
the selected profile.
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Connection area

Other Profile Settings area

Log table and log area

The table lists all the changes you have made in the Profiles tab.

The log area displays all commands and actions issued in the Labware 
MiniHub Diagnostics dialog box. The area is visible in the Profiles tab and the 
Controls tab.

Control Description

This MiniHub is 
connected via ethernet

Available only for G5584A MiniHub. Specifies an 
Ethernet communication connection between the 
device and the computer. 

Device ID Displays the device number of the Labware 
MiniHub that is communicating with the 
computer.

Find available device Opens the Discovered BioNet Devices dialog box, 
which lists the connected devices that the 
software finds.

This MiniHub is 
connected via serial

Available only for earlier models of the 
Labware MiniHub. Specifies a serial 
communication connection between the device 
and the computer. 

Serial port The COM port of the computer that is connected 
to the Labware MiniHub.

Control Description

Slots Per Cassette The number of shelves in each Labware MiniHub cassette.

Speed The rotational speed of the Labware MiniHub during 
protocol runs. The selections are:

• Slow. Turns the Labware MiniHub at 25% of the 
factory- set maximum speed.

• Medium. Turns the Labware MiniHub at 50% of the 
factory- set maximum speed.

• Fast. Turns the Labware MiniHub at 100% of the 
factory- set maximum speed.

To set the rotation speed while you are working in 
diagnostics, go to the Controls tab.
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Commands

Related information

Control Description

About Displays the Labware MiniHub Diagnostics 
version number and copyright information.

For information about... See...

Opening Labware MiniHub 
Diagnostics

“Opening Labware MiniHub Diagnostics” 
on page 25

Profiles “About profiles” on page 26

Creating a profile “Creating a Labware MiniHub profile” 
on page 26

Establishing communication “Initializing the Labware MiniHub” on 
page 30

Controls tab “Controls tab” on page 65
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Controls tab

Status area and commands

Control or 
indicator

Description

Cassette The cassette currently at the home position.

Position The current position of the Labware MiniHub, in degrees.

Speed The rotational speed of the Labware MiniHub while you are in 
diagnostics. The selections are:

• Slow. Turns the Labware MiniHub at 25% of the factory- set 
maximum speed.

• Medium. Turns the Labware MiniHub at 50% of the factory-
set maximum speed.

• Fast. Turns the Labware MiniHub at 100% of the factory- set 
maximum speed.

To set the rotation speed for protocol runs, go to the Profiles 
tab.
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Movement area

Motor area

Teach area

Related information

Fault The light that indicates whether the Labware MiniHub has 
encountered an error. If the light is on, an error has occurred.

Control or 
indicator

Description

Control Description

Jog counterclockwise Turns the Labware MiniHub counterclockwise by the 
selected degree increment: 1, 5, 30, 45, 90, or 180.

Jog clockwise Turns the Labware MiniHub clockwise by the 
selected degree increment: 1, 5, 30, 45, 90, or 180.

Rotate to degree Turns the Labware MiniHub so that cassette 1 is at 
the specified number of degrees from the home 
position.

Rotate to cassette Rotates the Labware MiniHub to the specified 
cassette, for example, the home position at 
cassette 1.

Control Description

Enable Turns on the Labware MiniHub motor.

Disable Turns off the Labware MiniHub motor.

Control Description

Go home Turns the Labware MiniHub to the home 
position.

Teach Home Sets the home position.

For information about... See...

Clearing controller faults “Checking the fault indicator” on 
page 52

Setting the home position “Setting the home position” on page 32

Profiles tab “Profiles tab” on page 62
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B
Labware MiniHub ActiveX control

This appendix contains the following topics:

• “About the Labware MiniHub ActiveX control” on page 68

• “Properties” on page 71

• “Methods” on page 74

• “Events” on page 88

Note: The Labware MiniHub ActiveX control has been verified to 
work in Visual Studio 2015.
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About the Labware MiniHub ActiveX control

What is the Labware MiniHub ActiveX control

The Labware MiniHub ActiveX control is the software component that allows 
third- party lab automation systems to interact with the Labware MiniHub.

How the Labware MiniHub ActiveX control is used

In an Agilent Technologies automation system that is running the VWorks 
software, ActiveX interfaces are not used to communicate with devices. 
However, some integrations, such as those with LIMS, require that a third-
party application control the Labware MiniHub. The Labware MiniHub ActiveX 
control enables third- party applications to interface with the Labware 
MiniHub.

Each ActiveX control consists of a collection of the following:

• Methods. Functions that can be called to invoke individual operations

• Properties. Variables that are used in methods (for example, speed = fast)

• Events. Notifications that methods have completed or resulted in errors

To ensure proper integration, you must know the available methods and 
properties for the ActiveX control.

The following figure illustrates the use of the Labware MiniHub ActiveX control 
in a lab automation system environment. Actions you perform are conducted 
through ActiveX methods. System responses are relayed back through ActiveX 
events or through return values and variables passed to methods.

Note: Although the Labware MiniHub ActiveX control generates events, the 
third- party application must implement handlers for them.

Using the ActiveX control

The Agilent ActiveX control is a Windows- based control. To use the control, 
you place it on a form or window. The form can be visible or hidden. The 
following procedure provides an example of how to set up the control using 
Microsoft Visual Studio.

To set up the ActiveX control using Visual Studio:

1 In Visual Studio, open the project form in the Forms Designer.

2 Right- click in the Toolbox area, and select Choose Items from the shortcut 
menu.
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3 In the Choose Toolbox Items window, click the COM Components tab, and select 
the check box of the desired control.

For the MiniHub ActiveX, select the MiniHub Control check box.

4 Click OK. The selected control appears in the Toolbox area.



B   
About the Labware MiniHub ActiveX control

70 G5584A Labware MiniHub User Guide

5 Drag the control onto your form.

 

Related information

For information about... See...

Integrating the Labware MiniHub 
ActiveX control

Installation instructions in the release 
notes

Labware MiniHub ActiveX 
properties

“Properties” on page 71



71

B   
Properties

G5584A Labware MiniHub User Guide

Properties

About this topic

This topic describes the following properties:

• “Blocking” on page 71

• “ControlPicture” on page 72

Blocking

VARIANT_BOOL Blocking

Description
Determines whether methods should block until completion or return 
immediately for asynchronous operation.

Acceptable values
• VARIANT_TRUE (C++) or True (Visual Basic .NET). The ActiveX control is 

forced to block or wait until a method completes before it returns control 
to the caller.

• VARIANT_FALSE (C++) or False (Visual Basic .NET). Returns control to the 
application immediately, and the caller should handle the events 
accordingly.

Default value
VARIANT_FALSE (C++) or False (Visual Basic .NET)

Blocking affects some methods differently. See each method’s description for 
the effect. Unless otherwise noted:

• In non- blocking mode (Block = VARIANT_FALSE or False), a method:

– Starts another thread of execution to perform the given method, 
returning control to the application immediately.

– Returns 0 on launching a new thread successfully; otherwise, returns 
nonzero, and an Error event is fired.

– If the method is successful, an event indicating completion is fired; if 
unsuccessful, an Error event is fired.

• In blocking mode (Block = VARIANT_TRUE or True), a method:

– Is executed.

– Returns 0 if it completes successfully; returns nonzero otherwise.

• Error message can be reviewed by calling GetLastError().

Labware MiniHub ActiveX methods “Methods” on page 74

Labware MiniHub ActiveX events “Events” on page 88

For information about... See...
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Visual C++ Example
// set the MiniHub in blocking mode

VARIANT_BOOL blocking=VARIANT_TRUE;

m_Minihub.PutBlocking (blocking);

// set the MiniHub in non-blocking mode

blocking=VARIANT_FALSE;

m_Minihub.PutBlocking (blocking);

// returns the blocking value

blocking = m_Minihub.GetBlocking ( );

// user should handle events if non-blocking!

Visual Basic .NET Example
‘set Labware MiniHub in blocking mode

Minihub1.Blocking=True

‘set Labware MiniHub in non-blocking mode

Minihub1.Blocking=False

‘returns the blocking value

Dim bMode as Boolean

bMode = Minihub1.Blocking

‘user should handle events if non-blocking!

ControlPicture

IPictureDisp*ControlPicture

Description
A read- only picture of the Labware MiniHub that can be used in the 
container’s application.

Parameters
None

Visual C++ Example
/* the CPicture class will be imported into your project

when the ActiveX is installed */

CButton button;

// create a button

CPicture MinihubPic;

// retrieve the picture

MinihubPic = m_Minihub.GetControlPicture();

// paint the bitmap onto the button

button.SetBitmap((HBITMAP) MinihubPic.GetHandle());

Visual Basic .NET Example
Dim iPicture As System.Drawing.Image = 
Minihub1.ControlPicture()

button.BackgroundImage = iPicture
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Related information

For information about... See...

MiniHub ActiveX control “About the Labware MiniHub ActiveX 
control” on page 68

Integrating the MiniHub ActiveX 
control

Installation instructions in the release 
notes

MiniHub ActiveX methods “Methods” on page 74

MiniHub ActiveX events “Events” on page 88



B   
Methods

74 G5584A Labware MiniHub User Guide

Methods

About this topic

The topic describes the following methods:

• “Abort” on page 74

• “AboutBox” on page 75

• “Close” on page 75

• “DisableMotor” on page 76

• “EnableMotor” on page 76

• “EnumerateProfiles” on page 77

• “GetActiveXVersion” on page 78

• “GetCassetteCount” on page 78

• “GetCurrentCassette” on page 79

• “GetCurrentPosition” on page 79

• “GetFirmwareVersion” on page 80

• “GetHomePositionOffset” on page 80

• “GetLastError” on page 81

• “GetMotorStatus” on page 81

• “GetSlotCount” on page 82

• “GetSpeed” on page 82

• “Ignore” on page 83

• “Initialize” on page 83

• “Jog” on page 84

• “Retry” on page 84

• “RotateToCassette” on page 85

• “RotateToDegree” on page 85

• “RotateToHomePosition” on page 86

• “SetSpeed” on page 86

• “ShowDiagsDialog” on page 87

• “TeachHome” on page 87

Abort

long Abort(void)

Description
Aborts a current task that is in the error state and clears the error.

Parameters
None

Return
0 if successful

Other value if there was an error
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Visual C++ example
long lres = m_Minihub.Abort();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.Abort()

AboutBox

void AboutBox(void)

Description
Displays the Labware MiniHub About dialog box that contains the ActiveX 
version number.

Parameters
None

Return
None

Visual C++ example
m_Minihub.AboutBox();

Visual Basic .NET example
Minihub1.AboutBox()

Close

long Close(void)

Description
Closes the intialized Labware MiniHub profile and disconnects from the 
Labware MiniHub.

Parameters
None

Return
0 if successful, and fires the CloseComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.Close();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.Close()
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DisableMotor

long DisableMotor(void)

Description
Turns off the MiniHub’s motor.

Parameters
None

Return
0 if successful, and fires the DisableMotorComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.DisableMotor();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.DisableMotor()

EnableMotor

long EnableMotor(void)

Description
Turns on the MiniHub’s motor.

Parameters
None

Return
0 if successful, and fires the EnableMotorComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.EnableMotor();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.EnableMotor()
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EnumerateProfiles

VARIANT EnumerateProfiles(void)

Description
Retrieves a list of defined profiles. The strings in this array are the profile 
names that should be used for the Initialize method.

Parameters

None

Return
An array of profile names

Visual C++ example
VARIANT vProfiles = m_Minihub.EnumerateProfiles();

SAFEARRAY *psa = vProfiles.parray;

BSTR* bstrArray; 

if

(FAILED(SafeArrayAccessData(psa,reinterpret_cast<void**>( 
&bstrArray))))

{

    VariantClear(&vProfiles);

    return;

}

for (ULONG i = 0; i < psa->rgsabound[0].cElements; i++)

{

    MessageBox(CString(bstrArray[i])));

}

SafeArrayUnaccessData(psa);

VaraintClear(&vProfiles);

Visual Basic .NET example
Dim i as Integer

Dim profileNames() As String

profileNames = Minihub1.EnumerateProfiles()

For i = 0 To profileNames.GetLength(0) - 1

MsgBox profileNames(i)

Next
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GetActiveXVersion

BSTR GetActiveXVersion(void)

Description
Retrieves the MiniHub ActiveX software version number.

Parameters
None

Return
ActiveX software version number (string)

Visual C++ example
CString ActiveXVer = m_Minihub.GetActiveXVersion();

Visual Basic .NET example
Dim sVersion As String

sVersion = Minihub1.GetActiveXVersion()

GetCassetteCount

long GetCassetteCount(short *nCassetteCount)

Description
Retrieves the cassette count. 

Note: In this version, the cassette count is always 4.

Parameters
short *nCassetteCount

Cassette count value

Return
0 if successful, and fires the GetCassetteCountComplete event

Other value if there was an error

Visual C++ example
short ncassettes;

long lres = m_Minihub.GetCassetteCount(&ncassettes);

Visual Basic .NET example
Dim ires as Integer

Dim shCassCount As Short = 0

ires = Minihub1.GetCassetteCount(shCassCount)
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GetCurrentCassette

long GetCurrentCassette(short* nCassetteIndex)

Description
Retrieves the ID of the cassette that is currently at the home position.

Parameters
short* nCassetteIndex

The ID of the cassette that is currently at the MiniHub’s home position

Return
0 if successful, and fires the GetCurrentCassetteComplete event

Other value if there was an error

Visual C++ example
short curcas;

long lres = m_Minihub.GetCurrentCassettePosition(&curcas);

Visual Basic .NET example
Dim ires as Integer

Dim shCassette As Short = 0

ires = Minihub1.GetCurrentCassette(shCassette)

GetCurrentPosition

long GetCurrentPosition(float* fPositionInDegree)

Description
Retrieves the MiniHub’s current position.

Parameters
float* fPositionInDegree

The current position (0–360) in degrees

Return
0 if successful, and fires the GetCurrentPositionComplete event

Other value if there was an error

Visual C++ example
short  curpos;

long lres = m_Minihub.GetCurrentPosition(&curpos);

Visual Basic .NET example
Dim ires as Integer

Dim siPos As Single = 0

ires = Minihub1.GetCurrentPosition(siPos)
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GetFirmwareVersion

BSTR GetFirmwareVersion(void)

Description
Retrieves the Agile controller firmware version number.

Parameters
None

Return
Agile controller version number (string)

Visual C++ example
CString str = m_Minihub.GetFirmwareVersion ();

Visual Basic .NET example
Dim sFirmVer As Strings

sFirmVer = Minihub1.GetFirmwareVersion()

GetHomePositionOffset

long GetHomePositionOffset(float* fPosition)

Description
Retrieves the MiniHub’s home position offset, which is the encoder counter 
value.

Parameters
float* fPosition

The home position offset value

Return
0 if successful, and fires the GetHomePositionOffsetComplete event

Other value if there was an error

Visual C++ example
float homepos;

long lres = m_Minihub.GetHomePositionOffset(&homepos);

Visual Basic .NET example
Dim ires as Integer

Dim siOffset As Single

ires = Minihub1.GetHomePositionOffset(siOffset)
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GetLastError

BSTR GetLastError(void)

Description
Retrieves the last known error condition.

Parameters
None

Return
An error string

Visual C++ example
CString str = m_Minihub.GetLastError();

Visual Basic .NET example
Dim sError As String = ""

sError = Minihub1.GetLastError()

GetMotorStatus

long GetMotorStatus(VARIANT_BOOL* bServoStatus)

Description
Checks to see whether the motor is on.

Parameters
VARIANT_BOOL* bServoStatus

The state of the motor:

• VARIANT_TRUE (C++) or True (Visual Basic .NET) if motor is on

• VARIANT_FALSE (C++) or False (Visual Basic .NET) if motor is off

Return
0 if successful, and fires the GetMotorStatusComplete event

Other value if there was an error

Visual C++ example
VARIANT_BOOL ismotoron;

long lres = m_Minihub.GetMotorStatus(&ismotoron);

Visual Basic .NET example
Dim ires as Integer

Dim bMotorStatus As Boolean

ires = Minihub1.GetMotorStatus(bMotorStatus)
                                                        



B   
Methods

82 G5584A Labware MiniHub User Guide

GetSlotCount

long GetSlotCount(short *nSlotCount)

Description
Retrieves the slot count (the total number of slots in a cassette).

Parameters
short *nSlotCount

The slot count value

Return
0 if successful, and fires the GetSlotCountComplete event

Other value if there was an error

Visual C++ example
short nslots;

long lres = m_Minihub.GetSlotCount(&nslots);

Visual Basic .NET example
Dim ires as Integer

Dim shSlots As Short

ires = Minihub1.GetSlotCount(shSlots)

GetSpeed

long GetSpeed(short* pSpeed);

Description
Retrieves the MiniHub’s current speed.

Parameters
short* pSpeed

The current speed: 0 (slow), 1 (medium), or 2 (fast).

Return
0 if successful

Other value if there was an error

Visual C++ example
short nSpeed;

long lres = m_Minihub.GetSpeed(&nSpeed);

Visual Basic .NET example
Dim ires as Integer

Dim shSpeed As Short

ires = Minihub1.GetSpeed(shSpeed)
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Ignore

long Ignore(void)

Description
Ignores the previously issued error and moves to the next step in the task. 
This is not a recommended course of action, as the errors are issued for a 
reason. However, ignoring some errors can be appropriate if the operator 
understands the implications.

Parameters
None

Return
0 if successful

Other value if there was an error

Visual C++ example
long lres = m_Minihub.Ignore();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.Ignore()

Initialize

long Initialize(BSTR Profile)

Description
Initializes the profile and starts communication with the Labware MiniHub 
using the parameters set in the profile. The profile specifies the serial 
connection used to communicate with the Labware MiniHub. The parameters 
for each profile can be adjusted in the Diagnostics dialog box on the Profiles 
page (by calling the ShowDiagsDialog method).

Parameters
BSTR Profile

The name of the profile to be used for initialization.

Return
0 if successful, and fires the InitializeComplete event

Other value if there was an error

Visual C++ example
// connect via serial connection specified in the profile

long lres = 
m_Minihub.Initialize(_bstr_t("MiniHubprofile"));

Visual Basic .NET example
‘connect via serial connection specified in the profile

Dim ires as Integer

ires = Minihub1.Initialize(“MiniHub profile")
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Jog

long Jog(float fDegree, VARIANT_BOOL bClockwise)

Description
Rotates the MiniHub a specified number of degrees from its current position.

Parameters
float fDegree

The number of degrees relative to the current position.

VARIANT_BOOL bClockwise

The direction of the rotation. Set Clockwise to VARIANT_TRUE (C++) or 
True (Visual Basic .NET) to rotate the stage clockwise. Set Clockwise to 
VARIANT_FALSE (C++) or False (Visual Basic .NET) to rotate the stage 
counterclockwise.

Return
0 if successful, and fires the JogComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.Jog(30.0, VARIANT_TRUE);

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.Jog(30.0,True)

Retry

long Retry(void)

Description
Retries the last action after an error occurred.

Parameters
None

Return
0 if successful

Other value if there was an error

Visual C++ example
long lres = m_Minihub.Retry();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.Retry()
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RotateToCassette

long RotateToCassette(short nCassetteIndex)

Description
Rotates the MiniHub so that the specified cassette is at the 0° position.

Parameters
short nCassetteIndex

The cassette number: 1, 2, 3, or 4.

Return
0 if successful, and fires the RotateToCassetteComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.RotateToCassette(1);

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.RotateToCassette(1)

RotateToDegree

long RotateToDegree(float fDegree)

Description
Rotates the MiniHub a specified number of degrees.

Parameters
float fDegree

The number of degrees to rotate the MiniHub. A positive value rotates the 
MiniHub clockwise. A negative value rotates the MiniHub counterclockwise.

Return
0 if successful, and fires the RotateToDegreeComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.RotateToDegree(90.0);

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.RotateToCassette(90.0)
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RotateToHomePosition

long RotateToHomePosition(void)

Description
Rotates the MiniHub so that cassette 1 is at the 0° position. This method is 
equivalent to the Go Home command in MiniHub Diagnostics.

Parameters
None

Return
0 if successful, and fires the RotateToHomePositionComplete event

Other value if there was an error

Visual C++ example
long lres = m_Minihub.RotateToHomePosition();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.RotateToHomePosition()

SetSpeed

long SetSpeed(short nSpeed)

Description
Sets the MiniHub’s rotation speed.

Parameters
short nSpeed

The speed value: 0 (slow), 1 (medium), or 2 (fast).

Return
0 if successful

Other value if there was an error

Visual C++ example
long lres = m_Minihub.SetSpeed(0);

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.SetSpeed(0)
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ShowDiagsDialog

void ShowDiagsDialog (VARIANT_BOOL modal, 
short securityLevel)

Description
Displays the Diagnostics dialog box that allows the operator to troubleshoot 
and correct problems. This method can be called before the Initialize method 
to create a profile. Contents displayed are based on the operator’s access level.

Parameters
VARIANT_BOOL modal

The mode of the dialog box. The dialog box displayed can be modal (does 
not permit users to access the parent window) or modeless (permits users 
to access the parent window). If the modal mode is desired, set modal to 
VARIANT_TRUE (C++) or True (Visual Basic .NET). If the modeless mode is 
desired, set modal to VARIANT_FALSE (C++) or False (Visual Basic .NET).

short securityLevel

The security level the operator has in the dialog box:

0 = Administrator

1 = Technician

2 = Operator

3 = Guest

- 1 = No access

Return
0 if successful

Other value if there was an error

Visual C++ example
m_Minihub.ShowDiagsDialog(VARIANT_TRUE,0);

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.ShowDiagsDialog(True,0)

TeachHome

long TeachHome(void)

Description
Sets the teachpoint at the MiniHub’s current position. The home position 
should be when cassette 1 is at the 0° position.

Parameters
None

Return
0 if successful, and fires the TeachHomeComplete event

Other value if there was an error
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Visual C++ example
long lres = m_Minihub.TeachHome();

Visual Basic .NET example
Dim ires as Integer

ires = Minihub1.TeachHome()

Related information

Events

About this topic

This topic describes the following events:

• “CloseComplete” on page 89

• “DisableMotorComplete” on page 89

• “EnableMotorComplete” on page 89

• “Error” on page 89

• “GetCassetteCountComplete” on page 90

• “GetCurrentCassetteComplete” on page 90

• “GetCurrentPositionComplete” on page 90

• “GetHomePositionOffsetComplete” on page 91

• “GetMotorStatusComplete” on page 91

• “GetSlotCountComplete” on page 91

• “GetSpeedComplete” on page 92

• “InitializeComplete” on page 92

• “JogComplete” on page 92

• “RotateToCassetteComplete” on page 92

• “RotateToDegreeComplete” on page 93

• “RotateToHomePositionComplete” on page 93

• “SetSpeedComplete” on page 93

• “TeachHomeComplete” on page 93

For information about... See...

MiniHub ActiveX control “About the Labware MiniHub ActiveX 
control” on page 68

Integrating the MiniHub ActiveX 
control

Installation instructions in the release 
notes

MiniHub ActiveX properties “Properties” on page 71

MiniHub ActiveX events “Events” on page 88
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CloseComplete

void CloseComplete(void)

Description
Occurs when the Close method is successful.

Parameters
None

Return
None

DisableMotorComplete

void DisableMotorComplete(void)

Description
Occurs when the DisableMotor method is successful.

Parameters
None

Return
None

EnableMotorComplete

void EnableMotorComplete(void)

Description
Occurs when the EnableMotor method is successful.

Parameters
None

Return
None

Error

void Error(short Number, BSTR* Description, long Scode, 
BSTR Source, BSTR HelpFile, long HelpContext, 
VARIANT_BOOL* CancelDisplay)

Description
Fires when an error occurs during any non- blocking method execution.

Parameters
BSTR* Description

The description of the error.

VARIANT_BOOL* CancelDisplay

The option to hide the error message dialog box. Set to VARIANT_TRUE 
(C++) or True (Visual Basic .NET).
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Note: short Number, long Scode, BSTR Source, BSTR HelpFile, and 
long HelpContext are not used.

Return
None

GetCassetteCountComplete

void GetCassetteCountComplete(short nCassetteCount)

Description
Occurs when the GetCassetteCountComplete method is successful.

Parameters
short nCassetteCount

The number of cassettes in the MiniHub.

Return
None

GetCurrentCassetteComplete

void GetCurrentCassetteComplete(SHORT dCassette)

Description
Occurs when the GetCurrentCassettePosition method is successful.

Parameters
SHORT dCassette

The cassette number.

Return
None

GetCurrentPositionComplete

void GetCurrentPositionComplete(float fPosition)

Description
Occurs when the GetCurrentPosition method is successful.

Parameters
float fPosition

The position, in degrees.

Return
None
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GetHomePositionOffsetComplete

void GetHomePositionOffsetComplete(float fPosition)

Description
Occurs when the GetHomePositionOffset method is successful.

Parameters
float fPosition

The position, in degrees.

Return
None

GetMotorStatusComplete

void GetMotorStatusComplete(VARIANT_BOOL bServoStatus)

Description
Occurs when the GetMotorStatus method is successful.

Parameters
VARIANT_BOOL bMotorStatus

The status of motor. 

Return
None

GetSlotCountComplete

void GetSlotCountComplete(short nSlotCount)

Description
Occurs when the GetSlotCount method is successful.

Parameters
short nSlotCount

The number of slots in the cassettes. 

Return
None
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GetSpeedComplete

void GetSpeedComplete(short* pSpeed)

Description
Occurs when the GetSpeed method is successful.

Parameters
short pSpeed

The current speed: 0 (slow), 1 (medium), or 2 (fast).

Return
None

InitializeComplete

void InitializeComplete(void)

Description
Occurs when the Initialize method is successful.

Parameters
None

Return
None

JogComplete

void JogComplete(void)

Description
Occurs when the Jog method is successful.

Parameters
None

Return
None

RotateToCassetteComplete

void RotateToCassetteComplete(void)

Description
Occurs when the RotateToCassette method is successful.

Parameters
None

Return
None
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RotateToDegreeComplete

void RotateToDegreeComplete(void)

Description
Occurs when the RotateToDegrees method is successful.

Parameters
None

Return
None

RotateToHomePositionComplete

void RotateToHomePositionComplete(void)

Description
Occurs when the RotateToHomePosition method is successful.

Parameters
None

Return
None

SetSpeedComplete

void SetSpeedComplete(void)

Description
Occurs when the SetSpeed method is successful.

Parameters
None

Return
None

TeachHomeComplete

void TeachHomeComplete(void)

Description
Occurs when the TeachHome method is successful.

Parameters
None

Return
None
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Related information

For information about... See...

MiniHub ActiveX control “About the Labware MiniHub ActiveX 
control” on page 68

Integrating the MiniHub ActiveX 
control

Installation instructions in the release 
notes

MiniHub ActiveX properties “Properties” on page 71

MiniHub ActiveX methods “Methods” on page 74
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C
Orderable spare parts

This appendix lists the Labware MiniHub spare parts you can order 
from Agilent Technologies. 
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Spare parts list

Related information

Part name Part number

Shelves

• Landscape (Integration Configuration) 

• Portrait (BenchCel Configuration)

G5508- 00013

G5400- 00036

Spacers

• 25.1 mm

• 8.4 mm

G5508- 20014

G5508- 20015

Rods, 6- mm threaded

• Integration Configuration

– DDR (46.6 cm)

– BenchBot (41 cm)

G5508- 20012

G5508- 20016

• BenchCel Configuration (30 cm) G5508- 20013

For information about... See...

Reporting problems “Reporting problems” on page 60

Reconfiguring the shelves G5584A Labware MiniHub Safety and 
Installation Guide

Safety information G5584A Labware MiniHub Safety and 
Installation Guide







User Guide

G5584-90000

Revision A, July 2017


	About this guide
	Accessing Agilent Automation Solutions user guides
	Introduction
	About the Labware MiniHub
	Safety information
	Hardware overview
	Software overview
	Quick start

	Setting up the device
	Setup workflow for the VWorks software
	Turning on and off the Labware MiniHub
	Creating a VWorks device file
	Adding and deleting a Labware MiniHub in the device file
	Setting Labware MiniHub properties

	Configuring profiles and setting teachpoints
	Configuration workflow
	Opening Labware MiniHub Diagnostics
	Creating Labware MiniHub profiles
	Editing and managing profiles
	Initializing the Labware MiniHub
	Setting the home position
	Setting robot teachpoints

	Using device diagnostics
	About Labware MiniHub Diagnostics
	Checking the current position of the device
	Enabling and disabling the motor
	Changing the rotation speed
	Rotating the MiniHub to a specific position
	Checking the fault indicator
	Viewing the log area

	Maintenance and troubleshooting
	Cleaning the shelves
	Troubleshooting hardware problems
	Troubleshooting error messages
	Reporting problems

	Quick reference
	Profiles tab
	Controls tab

	Labware MiniHub ActiveX control
	About the Labware MiniHub ActiveX control
	Properties
	Methods
	Events

	Orderable spare parts
	Spare parts list




